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1. Introduction

1.1 Overview

The Dagama S-91 is a tiny, low-power, ultra-high performance, easy to use SMT mountable GPS
receiver module based on SiRF’s latest third generation single chip. Its small size/low power
consumption/high performance enables the adoption of small handheld applications such as personal
navigation device, PDA, GPS watch, personal locator etc. Its SMT design allows automatic pick and
place assembly process. Additional convenient features of S-91 make it the best choice of GPS
application. In addition to the active and passive antenna support via pin RF_IN, an on-board I-PEX
connector to GPS antenna eliminates the complex performance tuning process. Just plug an antenna to
the I-PEX connector and the solution is ready for use. It reduces the development efforts and shortens the
development time. For active antenna applications, the built-in antenna surveillance not only reports the
anomaly of short circuit (accidental events) and open circuit (malicious cut of antenna) but also protects
the device. Not only the built-in software power saving mechanism, it also supports hardware power
saving via pin PWR_CTRL to fully cut off the power supply of S-91.

1.2 Main Features
Not only handheld but also any other GPS applications can share the following major features of S-91.
% Full implementation of ultra-high performance SiRFstarlll single chip architecture

% High tracking sensitivity of -159dBm

% Low power consumption of 40mA at full tracking

% Ultra-small size of 17 (W) x 22.4 (L) x 2.4 (H) (mm)

% Additional hardware power saving control pin

% Active and passive antenna support via pin RF_IN

% Additional I-PEX connector eliminates the efforts of RF performance tuning
% Backup power supply pin for hot/warm starts and better performance

% Embedded ARM7 CPU is available for external applications

% SMT automatic pick and place assembly support to reduce production cost
% Firmware upgradeable for future potential performance enhancements

% Fully shielded for EMC protection

% Active antenna surveillance and protection (optional)
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1.3. Technical Specifications
1.3.1. Electrical Characteristics

@ GPS receiver type 20 channels, L1 frequency, C/A code

@ Horizontal Position Accuracy < 2.5m (Autonomous)

< 2.0m (WAAS)
(50% 24hr static, -130dBm)

@ Velocity Accuracy <0.01 m/s (speed)
<0.01° (heading)
(50%@30m/s)
@ Time accuracy Ius or less
€ TTFF (Time to First Fix) Hot Start: 1s
(50%, -130dBm, autonomous) Warm Start: 35s

Cold Start: 42s

& Sensitivity Tracking: —159dBm

(Autonomous) Acquisition: -142dBm
(-142dBm 28dB-Hz with 4dB noise figure)

& Mecasurement data output Update time: 1 second

NMEA output protocol: V.3.00
Baud rate: 4800 (default), 9600, 19200, 38400,
57600 bps (8-N-1)
Datum: WGS-84
Default: GGA, GSA, RMC, VTG at 1Hz and
GSV at 1/5Hz
Other options: GLL, ZDA, or SiRF binary

@ Max. Altitude <18,000 m
& Max. Velocity <1,852 km/hr
@ SBAS Support WAAS, EGNOS
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& Dynamics <4g

& Power consumption 40mA, continuous tracking mode

@ Power supply 3.3V

& Dimension single side 17.0(W) x 22.4(L) x 2.4(H) mm
& Operating temperature range -40 °C to +85 °C

@ Storage temperature range -45°C to +100 °C

1.4 Protocols
Both NMEA and SiRF binary protocols could be supported via serial UART I/O port —
RXA/TXA. The default supported protocol is NMEA protocol.
1. Serial communication channel
1. No parity, 8-data bit, 1-stop bit (N-8-1)
i1. User selectable baud rate among 4800, 9600, 19200, 38400, and 57600
(default 4800) bps.
2. NMEA 0183 Version 3.00 ASCII output
1. Default GGA (1 sec), GSA (1 sec), GSV (5 sec), RMC (1 sec), VTG (1 sec)
ii. Optional GLL, ZDA

1.5 Programming Resources
The GPS receiver is embedded an internal ARM7 SOC. Its programming resources are available through
the use of SDK from SiRF. Following are its related programming resources:
¢ 50-MHz ARM7TDMI processor
¢ 1 Mb SRAM
¢ 4 Mb flash memory

Please note that the receiver itself will use part of above resources.

1.6 Antenna
Passive or active antenna via pin RF_IN, or External antenna via
Antenna Type
[-PEX connector
Active Antenna Minimum gain 18d B
Recommendation Maximum noise figure 1.5dB
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Antenna Supply Using VCC_REF or external power source
Short circuit detection Built-in
Short circuit protection Built-in
Short circuit report via GPIO Built-in
Antenna — - —
) Short circuit report via NMEA Built-in
Supervisor —— - —
Open circuit detection Built-in
Open circuit report via GPIO Built-in
Open circuit report via NMEA Built-in
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2 Hardware Interface

2.1 PCB Dimension
The dimension of S-91 is 17 mm (W) x 22.4 mm (L) x 2.4 mm (H).
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2.2 Pin Assignment
28-pin Interface

Name Function 1/0

Pin

1 |LED/GPIO1 |LED display for position fixing status or General Purpose |Output
I/O control pin 1. or
Default for LED indication: /O
Always “High” before position is fixed;
Alternating “High” “Low” if position has fixed.

GPIO2 General Purpose /O control pin 2 -
TXA Port A serial data output (from GPS); N-8-1, NMEA v3.00 |Output
output
4 |RXA Port A serial data input (to GPS); N-8-1, accepts commands
from external applications, e.g. SIRFDemo. Input
NC No connection -
VCC Main power supply of 3.3 + 0.3VDC. 3.3VDC is the Input

standard suggestion. This power is also used to keep the

power of clock and fixing data.

GND Ground Input
NC No connection -

9 |INC No connection -

10 |nRESET Engine board reset input signal, active low, at least 250ms. |Input

This pin could be connected to a micro-processor’s GPIO
pin to control the reset of the engine board. A low signal of
250ms will reset it and re-start the acquisition process again.

It may be left open if it is not used.

11 |V_BAT 2.0~3.6VDC backup battery connection for RTC and Power
internal RAM Input
- This pin is the source of the backup power supply. It or

allows the time and fixing data to be kept while the main  |Output
power (VCC) is cut off. The time and fixing data could be
used to help reduce the time to first fix (TTFF).

- A power source could be connected to this pin directly. It

inputs the power to keep clock and fixing data.
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- If connect a battery to this pin directly, then the built-in
charging circuit will charge the battery automatically using
the main power and thus this is an output pin. When the
main power is off, the battery power is used to keep clock

and the fixing data. In this case this is a power input.

12 | BOOTSEL |Firmware upgrade selection pin. Input
“NC” for normal run (internal pull-low);
“High” for firmware upgrade.

Leave this pin open if the firmware upgrade is not needed.

13 |GND Ground Input

14 [PWR_CTRL |Hardware controlled power saving pin. Input
If this function is used, it is usually connected to a GPIO pin
of a micro-processor.

“Low” for normal run;

“NC”: turn off VCC for power saving (internal pull-high)

Tie this pin to “Low” if it is not used.

15 |GND Ground Input

16 |RF_IN GPS signal from antenna; 50 Ohms @ 1.57542GHz Input
Either active or passive antenna signal could be connected
to this pin. Please do not

connect this pin if choose to connect antenna module to
the 1-PEX connector.

17 |GND Ground Input

18 |[VCC _RF VCC antenna power supply option. Leave it open if this  |Output
pin is not used.

This pin outputs the same DC voltage level as VCC (pin 6).
If this voltage level is compatible

to external active antenna, it could be used to power the
antenna. In this case, connect

VCC _RF to V_ANT. If external power source is preferred,

leave this pin open.

19 |V_ANT Active antenna power supply. Leave it open if a passive  |Input
antenna is used.
For active antenna, an antenna power supply is needed. This

supply could be from either external power source or from

the built-in power VCC_RF depending on the working
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power requirement of active antenna. The antenna power

source should be well-regulated (Vpp of noise should be

less than 50mV) so that the receiver could have best

performance.
20 |NC No connection -
21 |GPIO4 General Purpose /O control pin 4 /O
22 |GPIO13 General Purpose I/O control pin 13 /O
23 |INC No connection -
24 INC No connection -
25 |NC No connection -
26 |INC No connection -
27 |GPIO10 General Purpose I/O control pin 10 /0
28 |1PPS 1 Pulse Per Second signal output. The rising edge ofIPPS  |Output

pulse synchronized to GPS second with precision of better

than 1 micro-second, pulse width of 1 micro-second.
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2.3 Layout Suggestion
Following is the pad layout recommendation data:

Layout Recommendation Unit : mm

S-91 MM

224

2.4 Power Saving
S-91 supports various kinds of power saving mechanisms — Trickle Power,Adaptive Trickle Power,
Push To Fix, and power switch. The first three kinds of power saving mechanisms are implemented in

software and the power switch mechanism is implemented in hardware.

2.4.1 Power Saving of Trickle Power

The trickle power saving mechanism is achieved by switching off and on CPU and RF at a fixed
time interval. The biggest time interval to report a position is 10 seconds. The on and off ratio is
configurable. This feature is useful for applications that need to report position regularly while power
saving is significant. This feature is done by firmware automatically if this feature is enabled. The

standard firmware does not turn on this feature. It could be customized by request of MOQ.
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2.4.2 Power Saving of Adaptive Trickle Power
The adaptive trickle power saving mechanism is basically the same as trickle power saving
mechanism with difference that it would not turn the power off if the signal quality is not good enough
for tracking. Thus, it keeps both benefits of performance and power saving intelligently. This feature is
done by firmware automatically if this feature is enabled. The standard firmware does not turn on this

feature. It could be customized by request of MOQ.

2.4.3 Power Saving of Push To Fix
The Push To Fix power saving mechanism will not report position data until a specified time interval
expires or triggered by external event. Typically, to keep the up to date position data, it would wake up
to collect ephemeris and almanac data every 30 minutes. The time interval is also configurable. This
mechanism is especially useful for applications that need position data only on demand. This feature is
done by firmware automatically if this feature is enabled. The standard firmware does not turn on this

feature. It could be customized by request of MOQ.

2.4.4 Power Saving of Power Switch
The Power Switch power saving mechanism will turn off not only the CPU and RF but also the whole
engine board. The power saving is controlled by the external application via the control pin
(PWR_CTRL; pin 14). The engine board will be off if PWR_CTRL pin is not connected (internal
pull-high). It would be on if the pin is low.

The designer has full control of the power supply status of the engine board.

The power saving is also more complete. Applications such as AVL may prefer to turn it off while
the car engine is off and turn it on while the engine is ignited. Handheld applications such as PMP
navigator may prefer to stop GPS while it just wants movie watching. There might be similar demand
for different applications. This mechanism is achieved by hardware and external control of pin

PWR_CTRL is required if this mechanism is used. Tie it to low if the mechanism is not used.

2.5 Antenna Application
2.5.1 I-PEX Antenna Connection
The easiest way to use S-91 is to connect an antenna module via the [-PEX connector -no worry of
troublesome RF performance tuning. There are several options of antenna modules for different dimension
and cable length. The power source for active antenna module is connected to pin 19 (V_ANT). The

alternative way is to connect antenna to pin RF _IN as described in the following sections.
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2.5.2 RF_IN Antenna Connection — Passive Antenna
Following figure is a simple illustration of connecting a passive antenna. The passive antenna is
connected to Pin 16 (RF_IN). Please note that there is no connection to V. ANT.

TRkt ]

Fagsive Apenng

8
7
6
-]
4
3
2
1

In the above illustration, power control feature is not used. If this feature is used, connect
PWR_CTRL to a micro-processor GPIO pin.

For backup battery connection, just connect it to the V_BAT pin is enough. It’s very simple and it

does not need any other external components.

2.5.3 RF_IN Antenna Connection — Active Antenna
For active antenna, a DC power supply is required. This power supply of pin 19 (V_ANT) will then
be used to power the active antenna connected to pin RF_IN. Please do not connect the antenna power
supply to pin RF_IN directly. The quality of antenna power affects the RF performance significantly.
The peak to peak noise level should be less than 50mV.
There are two power sources for V. ANT — the on-board power VCC_RF (pin 18) and external power

source.
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Powered by on-board VCC_RF

The main power supply of VCC (pin 6) could be used to power an active antenna. For this
application, connect pin 18 (VCC_RF) to pin 19 (V_ANT) directly. To meet the stable power supply
requirement, the peak to peak noise level of VCC (pin 6) should be less than 50mV. The active
antenna is connected to Pin 16 (RF_IN).

Powered by External Power Source
Following figure is a simplified illustration of connecting an active antenna with external active

antenna power source. The active antenna is connected to Pin 16 (RF_IN).

2.5.4 Active Antenna Status Detection and Short Circuit Protection
S-91 supports active antenna status detection without aid of external circuit. States of open circuit
and short circuit could be detected. In addition, the short circuit protection circuit is also embedded

inside it.

Antenna requirement for this function requires:
e voltage level to be between DC 3V~5V

e power consumption of 100mA and larger is treated as short circuit
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e power consumption of 4mA and less is treated as open circuit

2.5.5 Active Antenna Status Notification

Antenna status is reported in ways of both hardware and software.
Hardware Antenna Status Notification

The antenna status is reported using pin 27 (GP1010).

High --  Either short circuit or open circuit has been detected

Low --  Normal; neither short circuit nor open circuit is detected

Software Antenna Status Notification

The antenna status is reported with proprietary NMEA protocol - SGPADT.

Normal condition $SGPADT,0*5A
Open circuit $GPADT,1*5B
Short circuit $GPADT,2*58
The Specifications are subject to be changed without notice. Copyright @ 2008, Dagama Navigation. 15 of 25
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2.6 RF_IN Impedance Matching

The GPS signal is delivered from antenna to S-91 via pin RF_IN. For the best delivery of GPS signal,
the signal trace from antenna to pin RF_IN should be well matched to impedance of 50-ohm.
Otherwise the performance would be degraded. The RF_IN impedance matching arrangement is

discussed in antenna types of passive and active as following.

Isolation between Ground

PATCH Antenna Pad

SiRFstarlll

NC
NC
NC
NC
GPIO10
1PPS/GPIO9

NC
RXA
TXA
NC
LED/GPIO1

Above figure is an illustration of patch antenna layout. Following items should be considered while
arranging the signal trace:
e Width of signal trace
e [solation width between signal trace and ground
e PCB structure and thickness
e Matching network (consists of L or C) along with the signal trace and near the RF_IN side for

impedance tuning.
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Following figure is another example of active antenna:

5-91
Top View
PWR_CTRL
GND
BOOTSEL
V_BAT
nRESET
NC

Isclation between Ground

\ Ground rl-p_
To Active Anlenna 5
* ’\. . 4 I 19]
| /‘. a j‘, |
Signal Trace Width / / ;

e

SiRFstarll
NC

GND
vCC

NC
RXA

L =
o Sty 5 RF_IN
Active T
Antenna I

NC
1PPS/GPIO8 LED/GPIO1

Basically, the consideration is the same as that of passive antenna. The major difference is the
matching network. Please note that other kind of matching network is also possible to match it to the

50 ohms impedance.
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2.7 1PPS output
The 1 pulse per second signal output is a precise reference time signal. The rising edge of 1PPS pulse
is synchronized to GPS second with precision of better than 1 micro-second, pulse width of 1

micro-second.

Cursar 2

1.040 us
CHT 7 1367
<10Hz

Please note that 1PPS signal will not output until the position has been fixed. Above is the 1PPS

signal taken from the screen of oscilloscope.

3 Software Interface

3.1 NMEA Output Messages
The NMEA-0183 Output Messages are shown as below:

NMEA Record

Descriptions
GPGGA Global positioning system fixed data: time, position, fixed type
GPGLL Geographic position: latitude, longitude, UTC time of position fix and status
GPGSA GPS receiver operating mode, active satellites, and DOP values
GPGSV GNSS satellites in view: ID number, elevation, azimuth, and SNR values
GPRMC Recommended minimum specific GNSS data: time, date, position, course, speed
GPVTG Course over ground and ground speed
GPZDA PPS timing message (synchronized to PPS)

The S-91 easy to use mountable GPS engine board adopts interface protocol of National Marine

Electronics Association's NMEA-0183 Version 3.00 interface specification. S-91 supports 8 types of

The Specifications are subject to be changed without notice. Copyright @ 2008, Dagama Navigation. 18 of 25
Confidential 2008/08/08  Version:1.0



DAG A mA S-91 Manual V1.0

sentences - 7 standard NMEA sentences (GPGGA, GPGLL, GPGSA, GPGSV, GPRMC, GPVTG, and
GPZDA) and a proprietary sentence (GPADT).

The default output sentences are GPGGA, GPGSA, GPGSV, GPRMC, and GPVTG.

The UART communication parameters are 4800 bps, 8 data bits, 1 stop bit, and no parity. Other

output sentences, baud rate, and related configurations could be requested based on MOQ.

Single message example
$GPGGA,101229.487,3723.2475,N,12158.3416,W,1,07,1.0,9.0,M, , , ,0000*3E
$GPGLL,2446.8619,N,12100.2579,E,060725.000,A,A*7E
$GPGSA,A,3,05,02,26,27,09,04,15, ,,,,,1.8,1.0,1.5%11
$GPGSV,3,1,12,07,62,081,37,16,61,333,37,01,60,166,37,25,56,053,36*74
$GPGSV,3,2,12,03,43,123,33,23,32,316,34,14,17,152,30,20,16,263,33*78
$GPGSV,3,3,12,19,17,210,29,06,08,040,,15,06,117,27,21,05,092,27*7E
$ GPRMC,151229.487,A,3723.2475,N,12148.3416,W,0.13,309.62,120598,,,A*5F
$GPVTG,,T,,M,0.00,N,0.0,K,A*13
$GPZDA,060526.000,20,06,2006,,*51
$GPADT,0*5A

3.2 GPGGA - Global Positioning System Fix Data
» Example

$GPGGA,101229.487,3723.2475,N,12158.3416,W,1,07,1.0,9.0,M, , , ,0000*3E
» Explanation

Contents Example Unit Explanation
Message ID $GPGGA GGA protocol header
UTC Time 101229.487 hhmmss.sss

hh: hour, mm: minute, ss: second
Latitude 3723.2475 ddmm.mmmm

dd: degree, mm.mmmm: minute
North/South N N: North Latitude, S: South Latitude
Longitude 12158.3416 dddmm.mmmm

dd: degree, mm.mmmm: minute
East/West W E: East Longitude, W: West Longitude
Position Fix Indicator |1 0: Fix not available or invalid,

1: GPS SPS Mode, fix valid,

2: Differential GPS, SPS Mode, fix valid,

3~5: Not supported,
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6: Dead Reckoning Mode, fix valid
Satellites Used 07 Number of satellites used in positioning
calculation (0 to 12)
HDOP 1.0 Horizontal Dilution of Precision
MSL Altitude 9.0 meters
Unit M Meters
Geoidal separation meters
Units M Meters
Age of Diff. Corr. second  |[Null fields when DGPS is not used
Diff. Ref. Station ID |0000
checksum *3E
<CR><LF> End of sentence

3.3 GPGLL - Geographic Position - Latitude / Longitude
» Example

$ GPGLL,2446.8619,N,12100.2579,E,060725.000,A,A*7E
» Explanation

Contents Example Unit Explanation
Message ID $GPGLL GLL protocol header
Latitude 2446.8619 ddmm.mmmm

dd: degree, mm.mmmm: minute

North/South N N: North Latitude, S: South Latitude

Longitude 12100.2579 dddmm.mmmm

dd: degree, mm.mmmm: minute

East/West E E: East Longitude, W: West Longitude

UTC Time 060725.000 hhmmss.sss

hh: hour, mm: minute, ss: second

Status A A: Data valid, V: Data invalid
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Mode Indicator A A: Autonomous, D: DGPS, E: DR
checksum *TE
<CR><LF> End of sentence

3.4 GPGSA - GNSS DOP and Active Satellites

» Example
$GPGSA,A,3,05,02,26,27,09,04,15, ,,,,,1.8,1.0,1.5%11

» Explanation
Contents Example |Explanation
Message ID  |[SGPGSA |GSA protocol header
Mode 1 A M: Manual—forced to operate in 2D or 3D mode

A: 2D Automatic—allowed to automatically switch 2D/3D

Mode 2 3 1: Fix not available

2: 2D (< 4 Satellites used)
3: 3D (> 3 Satellite s used)

Satellite used |05 Satellite on Channel 1
in solution
Satellite used (02 Satellite on Channel 2

in solution

Display of quantity used (12 max)

PDOP 1.8 Position Dilution of Precision

HDOP 1.0 Horizontal Dilution of Precision
VDOP 1.5 Vertical Dilution of Precision
checksum *11

<CR><LF> End of sentence

3.5 GPGSV - GNSS Satellites in View
» Example

$GPGSV,2,1,07,07,79,048,42,02,51,062,43,26,36,256,42,27,27,138,42%71
$GPGSV,2,2,07,09,23,313,42,04,19,159,41,15,12,041,42%41
» Explanation

Contents Example |Unit Explanation
Message ID |$GPGSV GSV protocol header
The Specifications are subject to be changed without notice. Copyright @ 2008, Dagama Navigation. 21 of 25

Confidential 2008/08/08 Version: 1.0



DAG A mA S-91 Manual V1.0

Number of |2 Range 1 to 3

messages

Message 1 Range 1 to 3

number

Satellites in |07 Number of satellites visible from receiver

view

Satellite ID |07 Channel 1 (Range 1 to 32)

number

Elevation 79 degrees |Elevation angle of satellite as seen from receiver
channel 1 (00 to 90)

Azimuth 048 degrees |Satellite azimuth as seen from receiver
channel 1 (000 to 359)

SNR (C/No) |42 dBHz Received signal level C/No from receiver

channel 1 (00 to 99, null when not tracking)

Satellite ID |27 Channel 4 (Range 1 to 32)

number
Elevation 27 degrees |Elevation angle of satellite as seen from

receiver channel 4 (00 to 90)

Azimuth 138 degrees |Satellite azimuth as seen from receiver
channel 4 (000 to 359)
SNR (C/No) |42 dBHz Received signal level C/No from receiver

channel 4 (00 to 99, null when not tracking)

checksum *71

<CR><LF> End of sentence

3.6 GPRMC - Recommended Minimum Specific GNSS Data
» Example

$GPRMC,151229.487,A,3723.2475,N,12148.3416,W,0.13,309.62,120598,,,A*5F
» Explanation

Contents Example Unit Explanation
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Message ID |$GPRMC RMC protocol header
UTC Time [151229.487 hhmmss.sss

hh: hour, mm: minute, ss: second
Status A A: Data valid, V: Data invalid
Latitude 3723.2475 ddmm.mmmm

dd: degree, mm.mmmm: minute
North/South |N N: North Latitude, S: South Latitude
Longitude [12148.3416 dddmm.mmmm

dd: degree, mm.mmmm: minute
East/West  |W E: East Longitude, W: West Longitude
Speed over |0.13 knots Receiver’s speed
ground
Course over (309.62 degrees |Receiver’s direction of travel
ground Moving clockwise starting at due north
Date 120598 ddmmyy

dd: Day, mm: Month, yy: Year
Magnetic degrees |This receiver does not support magnetic
variation declination. All “course over ground” data are

geodetic WGS84 directions.
Mode A A: Autonomous, D: D-GPS, N: Data not valid
Indicator
checksum  [*5SF A: Autonomous M: Manual

D: DGPS S: Simulation

E: Dead Reckoning N: Data Invalid
<CR><LF> End of sentence

3.7 GPVTG - Course Over Ground and Ground Speed
» Example

$GPVTG,309.62,T,,M,0.18,N,0.5,K,A*OF
» Explanation

Contents Example |Unit Explanation
Message ID $GPVTG VTG protocol header
Course over ground 309.62  |degrees |Receiver’s direction of travel

Moving clockwise starting at due north
(geodetic WGS84 directions)
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Reference T True

Course over ground degrees Receiver’s direction of travel
Reference M Magnetic

Speed over ground 0.18 knots Measured horizontal speed

Unit N Knots

Speed over ground 0.5 km/hr Measured horizontal speed

Unit K km/hr

Mode Indicator A A: Autonomous, D: DGPS, E: DR
checksum *OF

<CR><LF> End of sentence

3.8 GPZDA - SiRF Timing Message

» Example

$GPZDA,181813,14,10,2006,00,00*4 A

» Explanation

Contents Example |Unit  |[Explanation

Message ID $GPZDA ZDA protocol header

UTC time 181813 Either using valid IONO/UTC or estimated from
default leap seconds

Day 14 Day according to UTC time (01 to 31)

Month 10 Month according to UTC time (01 to 12)

Year 2006 Year according to UTC time (1980 to 2079)

Local zone hour 00 hour |Offset from UTC (set to 00)

Local zone minutes |00 minute |Offset from UTC (set to 00)

checksum *4F

<CR><LF> End of sentence

3.9 GPADT — Antenna Detection Message

» Example
$GPADT,0*5A
» Explanation

Contents Example |Unit |Explanation
Message ID $GPADT ADT protocol header
State 0 0: Normal condition
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1: Open circuit
2: Short circuit

checksum *SA
<CR><LF> End of sentence
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